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Numerical Heat Transfer

Chapter 13 Application examples of fluent for flow and heat 
transfer problem
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13. 3  Pool boiling heat transfer

Problem descriptions：A pool is filled with liquid water.
Part of the bottom wall is heated with constant
temperature. Phase change takes place and bubbles will
be generated, leading to the pool boiling heat transfer
process.

Outlet

Side

Bottom

Temperature

Boundary conditions

Side walls Symmetry

Outlet Pressure outlet

Bottom: constant 

temperature

Wall, 573.15K, 10o

Bottom：
adiabatic

Wall, adiabatic, 120o
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S. Nukiyama, The maximum and minimum values of the heat Q transmitted from metal to boiling 

water under atmospheric pressure. Int. J. Heat Mass Transf., 9 (12) (1934), pp. 1419-1433
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◼ Find: bubble dynamic behaviors during the pool
boiling.

Solution:

Continuity, momentum and energy equation for 

pooling boiling heat transfer?

The governing equations for pool boiling phase

change heat transfer is a little different from the

original NS equation. Equations for multiphase flow

is required. We will study background information of

multiphase flow and then derive the equations.
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1). Background of Multiphase flow
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Multiphase fluid flows are ubiquitous in natural, scientific and

engineering systems

Same component (单组分多相）: 

Multiple components （多组分多相）: 

Liquid water and water vapor system 

Small density:  water and oil system

Large density ratio: water and air system
Crown

A phase refers to gas, liquid or solid state of matter. A multiphase

flow is the flow of a mixture of phases such as gas (bubbles) in a

liquid, or liquid (droplets) in a gas, and so on.
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Droplet spread(飞沫传播）, provided by PhD 

Meng-Yi Wang from NHT group

Multiphase flow during cough
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2). Fundamental definitions

Surface tension: refers to the tensile force exists at the phase

interface separating two fluids, due to a mutual attraction

between molecules near the interface

unit: N/m   Typical value: water-air: 0.0725 N/m

9/76

/
/


θ>90° θ=90 ° θ<90 °

Contact angle

10/76

measurement of the surface wettability. The angle of the triple-

phase line. Hydrophilic surface (亲水）with angle less than 90,

liquid tends to spread. Hydrophobic surface （疏水）with angle

higher than 90, liquid tends to form droplet. Neutral surface

（中性表面） with angle as 90.
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p1
p2

Capillary pressure

𝑃c = 𝑃1 − 𝑃2 =
𝜎cos𝜃

𝑟
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pressure difference across a phase interface, related to the 

surface tension force 

Because of the capillary

pressure, a liquid can flow in

narrow spaces without the

assistance of, or even in

opposition to, external forces

like gravity. mercury
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3）. Different methods for multiphase flow

Volume of Fluid (VOF) 流体体积法

Macroscopic

Level Set (LS) 水平集法

Phase-field 相场方法

Front tracking  前沿跟踪方法

Mesoscopic
Lattice  Boltzmann Method, Smooth Particle Hydrodynamics

格子Boltzmann 方法，光滑粒子方法

Microscopic

Molecular dynamics （分子动力学）

VOSET

by NHT group
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4）. Volume of Fluid (VOF)

Proposed by Hirt and Nichols in 1981.
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Volume of fluid （体积分数）：basic variable in VOF

The volume fraction of each fluid in a computational cell

cell

m
m

V
C

V
= 1mC =

For two-phase flow: primary phase （主相） and 

secondary phase （次相）

1 1C = The cell is filled with the primary phase

1 0C = The cell is free of primary phase

( , )1 0 1C  The cell is partially filled with primary phase
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Schematic of 2D two-phase flow system
C is a scalar.

primary phase 

secondary phase 

1 1C = The cell is filled with the primary phase

1 0C = The cell is free of primary phase

( , )1 0 1C  The cell is partially filled with primary phase
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Governing equation of C

The change of C is due to the flow in/out of the corresponding

phase into a cell.

C is evolved according to local velocity obtained from solving the

N-S equations

0m
m

C
C

t


+  =


u

Unsteady term Convection term

The two phases are not soluble（互溶）, so there is no diffusion

term. When there is chemical reaction or phase change, source

term is not zero

Convection-diffusion type equation
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The governing equations for single phase flow with

VOF
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Surface tension force

Two-way coupled with each other
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Continuum surface force (CSF) model

The form of volumetric force (体积力，N/m3) is

required in NS equation. However, surface tension force

is a kind of surface force, rather than volumetric force.

✓ Smooth C

➢ VOF in fact is a sharp-interface

model.

➢ The thickness of the interface is

zero.

➢ The fluid property is sharply

changed from 1 to 0 across the

interface.
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The purpose of smoothing C is to make C changes

gradually from 1 to 0.

C Water

Gas

C=1

C=0.75

C=0.5

C=0.25

C=0

In microscopic, however, the interface is not sharp, it

has a finite thickness, for example, of a few nanometers.

Therefore, transition from phase 1 to phase 2 is smooth.
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, , , ,

,

( , )i j m n i j m n

m n

C C K = − r r

The following function is adopted to smooth C


Control the thickness of the interface! 3∆

i , j

m,n

, ,i j m n−r r

Distance between two points (i,j) and (m,n)

K Smooth integration kernel

Smoothed one
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l

l

( )
| |

C
k

C


=



interface mean curvature

Smoothed C, namely      , is adopted to calculate forceC

C= n

pressure in the transition region is

g g( )x x g xP P k C C P kC = + − = +

g( ) ( ( ))x x gP P k C C

k C





 − =  −

= 

F ~

Suppose local k is constant.

l

l g

2
( )

C
k




 


=

+
F

pg

pl
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0m
m

C
C

t


+  =


u

( ) 0m
m

C
C

t


+ =


u

Conservation form

(1). This is a convection-diffusion equation without diffusion

term, and can be solved using schemes introduced in NHT.

How to solve the VOF equation?

However, because C is not a continuous function. Such method

may result in false diffusion, leading to gradually increasing

thickness of the interface.
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（2）. Reconstruction method

Step 1. Interface reconstruction

For a value of C in a computational cell, the pattern of interface

should be determined first.

For example, for C=0.5, the interface may be as follows.

Then which one is the right interface?

1

2

3 4 5

…
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There are totally 16 kinds of interface pattern,

depending on local C and normal direction (nx, ny)

1. nx>0, ny>0

2. nx>0, ny<0

3. nx<0, ny<0

4. nx<0, ny>0

rotation

translation

mirroring
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Normal direction of the interface

Interface normal direction

Volume of fraction
Interface is reconstructed!

For example, for C=0.5, nx=0, ny=1

1

2

3 4 5

…
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Normal direction of the interface

Interface normal direction

Volume of fraction
Interface is reconstructed!

For example, for C=0.5, nx= , ny=

1

2

3 4 5

…

/2 2 /2 2
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By the reconstruction scheme, the phase interface is

determined in each computational cell.

Piecewise linear interface calculation (PLIC)

The smooth interface is approximately described by a 

set of lines.

D.L. Youngs, Time-dependent 

multi-material flow with large 

fluid distortion, Numerical 

methods for Fluid Dynamics, 1982, 

24(2), 273-285
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Step 2. Interface advection in a given velocity field

Based on the reconstructed phase interface, calculate

the variation of C according to local velocity filed, and

then update the C for next time step.

Taking 1D interface as example.

i-1 i i+1

Ci-1=1 Ci+1=0Ci

∆x

Ci∆x u
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i-1 i i+1

Ci∆x

The volume that flows from i-1 to i is

-1/2 -1/2i iF u t= 

-1/2iu

The volume that flows from i to i+1 is

1/2

1/2

1/2 1/2

0 (1 )

(1 ) (1 )

i i

i

i i i i

u t C x
F

u t C x u t C x

+

+

+ +

  − 
= 

 − −    − 

∆x

1/2iu +

(1 )iC x− 

Total volume is
1/2 1/2( ) /t t t

i i i iC C F F x+

− += + − 
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1/2 1/2( ) /t t t

i i i iC C F F x+

− += + − 

CFL condition

/u t x 
Because C should be smaller than 1, thus

also should be smaller than 1. This is the CFL

condition.

/u t x 

Therefore, during the numerical simulation, the time

step should be sufficiently low that the CFL condition

is satisfied, or the Counrant number <1.

Counrant number 
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5. Phase-change model: Lee Model

sat
v l g g

sat

satfor condensation ( > T)

T T
S S

T

T

 
−

= − =

sat
v l l l

sat

satfor evaporation ( < T)

T T
S S

T

T

 
−

= − =

l l
l

C S
C

t 


+  =


u

v v
v

C S
C

t 


+  =


u

W.H. Lee, A pressure iteration scheme for two-phase flow modelling, in: T.N. Veziroglu (Ed.), Multiphase 

Transport Fundamentals, Reactor Safety, Applications, Hemisphere, Washington, DC, 1980, pp. 61–82.
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2.1 Launch ANSYS Fluent

◼ Choose 2-Dimension

◼ Choose Display Options

◼ Choose Double Precision

◼ Choose Serial Processing

2  Process of simulation
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2.2 Read the mesh

File → Read→Mesh
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General→Mesh→Check

2.3 Check the mesh
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◼ Choose Specify Scaling Factor

◼ Convert the unite from m to mm.

2.4 Scale the domain size

General→Mesh→Scale
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2.5 Choose the solver

◼ Choose Transient

The dynamic behaviors of

bubble is to be studied.

General→Solver

◼ Select Gravity

◼ Write -9.8 in the

Gravitational

Acceleration box

of Y.

Density-based method cannot be used for VOF.
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The velocity formulation resulting in

most of the flow domain

having the smallest velocities is

recommended, thereby reducing the

numerical diffusion in the solution and

leading to a more accurate solution.

◼ The absolute velocity formulation is preferred in 

applications where the flow in most of the domain is 

not moving (for example, a fan in a large room). 

◼ The relative velocity formulation is appropriate when 

most of the fluid in the domain is moving, as in the 

case of a large impeller in a mixing tank.
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2.6 Choose the models

Solution Setup→Models

◼ Choose Volume of Fluid as Multiphase Model
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2.6 Choose the models

Solution Setup→Models

◼ Select to open Energy Equation
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2.6 Choose the models

Large body forces (for example,

gravity or surface tension forces)

are included.

Body force and pressure

gradient are almost in equilibrium.

Implicit body force is adopted to

improve solution convergence by

accounting for the partial

equilibrium of the pressure

gradient and surface tension

forces.

Body force formulation
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Forces in VOF

T l

l g

( )
( ) [ ( )] 2
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C
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 +

u
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Inertial force

Pressure

Viscous force 

gravity Surface 

tension 

force

Multiphase flow is controlled by a set of forces. 

Body force

* Here surface tension force is converted to body force using CSF.
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2.7 Define the materials

Solution Setup→ Materials→Create/Edit Material

◼ Create water-liquid

1. Click Fluent Database

2. Choose water-liquid

3. Set Standard State 

Enthalpy to 0

4. Click Copy
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2.7 Define the materials

Solution Setup→ Materials→Create/Edit Material

◼ Create water-vapor

1. Click Fluent Database

2. Choose water-vapor

3. Set Standard State 

Enthalpy to 2.9923e7

4. Click Copy

The difference between the 

Standard State Enthalpy of 

two phases is the latent heat 

of phase change.
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2.8 Define the phases

Solution Setup→ Phases

◼ Choose water-liquid as Primary Phase

◼ Choose water-vapor as Secondary Phase

◼

Primary phase is usually set as the one dominated in the 

computational domain.
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2.8 Define the phases

1. Click Interaction

2. Click Surface Tension

3. Select Surface Tension 

Force Modeling

4. Choose Continuum 

Surface Force and Wall 

Adhesion

5. Choose constant and 

write 0.0725

Define surface tension force
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2.8 Define the phases

1. Click Interaction

2. Click Mass

3. Change Number of Mass 

Transfer Mechanisms to 1

4. Select Mechanism as

evaporation-condensation

5. Set Evaporation and 

Condensation Frequency to 0.1

6. Set Saturation Temperature to 

373.15

Define phase-change model
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2.8 Define the phases

phase-change model: Lee Model

Simplified model with phase change defined such that 

saturating conditions at the interface can be achieved.
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2.9 Define cell zone conditions

Solution Setup→ Cell Zone Condition →Operating Conditions 

49/76

Specified operating density

Set the operating density to be 

the density of the lightest phase.

Here input the density of the 

water-vapor.
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2.10 Define the boundary conditions

Solution Setup→ Boundary Condition

◼ For the boundary on both 

sides, define symmetry 

condition.

◼ For the outlet, define 

pressure outlet

◼ Set backflow temperature

50/76
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2.10 Define the boundary conditions

For the bottom surface, Define contact angle

◼ Choose wall as Type 

◼ Input value of the contact 

angle 120o for adiabatic wall, 

10o for high temperature wall.

◼ The angle is measured by 

vapor here.
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2.10 Define the boundary conditions

For the bottom surface, Define heat boundary condition

◼ For the adiabatic wall, set 

heat flux to zero.

◼ For the high temperature 

wall, set temperature to 

573.15 K.
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2.11 Choose the solution methods

Solution → Solution Methods 

◼ Choose PISO (Scheme)

◼ Choose Green-Gauss 

Cell Based (Gradient)

◼ Choose Body Force 

Weighted (Pressure)

◼ Choose Second Order 

Upwind (Momentum)

◼ Choose Geo-Reconstruct 

(Volume Fraction)
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The Pressure-Implicit with Splitting of Operators (PISO) 

The PISO also belongs to the family of SIMPLE.

There are one time of prediction step (预估） and correction 

step (校正） in SIMPLEC. 

Prediction step: determine u* and v* based on u0 and v0

Correction step: solve pressure correction, obtain u and 

v that satisfying the Mass Conservation Equation.

In PISO, two times of correction steps are conducted, 

thus improving the convergence.

PISO is  recommended for transient problem.
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2.11 Choose the solution methods

Solution → Solution Methods 

◼ Choose PISO (Scheme)

◼ Choose Green-Gauss 

Node Based (Gradient)

◼ Choose Body Force 

Weighted (Pressure)

◼ Choose Second Order 

Upwind (Momentum)

◼ Choose Geo-Reconstruct 

(Volume Fraction)
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Gradient calculation

The former two are based on Green-Gauss Theory

1. Green-Gauss Cell-Based (格林-高斯基于单元法）

2. Green-Gauss Node-Based (格林-高斯基于节点法)

3. Least-Squares Cell Based基于单元体的最小二乘法

It is the default scheme for gradient calculation.

1 1

C

f

C CV

dV dS S
V V

      =  =  =   n n

The least-square cell based is based on 

2

0

1

N

i Ci C i i i

i

w x y z
x y z


=

      
= − −  +  +    

      


  
 
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2.11 Choose the solution methods

Solution → Solution Methods 

◼ Choose PISO (Scheme)

◼ Choose Green-Gauss 

Node Based (Gradient)

◼ Choose Body Force 

Weighted (Pressure)

◼ Choose Second Order 

Upwind (Momentum)

◼ Choose Geo-Reconstruct 

(Volume Fraction)
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4. Body Force Weighted scheme

Calculate the pressure according to the body force.

✓ Multiphase flow such as VOF (Volume of Fluid，体

积函数法) or LS (Level Set, 水平集): recommended.

✓ For porous media: not recommended!

5. PRESTO! (Pressure Staggering Option) scheme

For problem with high pressure gradient.

1. Linear scheme

2. Standard scheme

3. Second Order

Pressure calculation
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2.11 Choose the solution methods

Solution → Solution Methods 

◼ Choose PISO (Scheme)

◼ Choose Green-Gauss 

Node Based (Gradient)

◼ Choose Body Force 

Weighted (Pressure)

◼ Choose Second Order 

Upwind (Momentum)

◼ Choose Geo-Reconstruct 

(Volume Fraction)
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The geometric reconstruction interpolation scheme

recommended when time-accurate transient behaviors

of the multiphase are required. In other words, it can

accurately predict the sharp interface. This scheme is

the most accurate and is applicable for general

unstructured meshes.

Solving methods for VOF equation

Modified HRIC, Compressive, and CICSAM schemes

are less computationally expensive than the Geo-

Reconstruct scheme, the interface between phases will

not be as sharp as the geometric reconstruction

interpolation scheme.
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2.12 Define the monitors

Solution → Monitors

◼ Define the Residuals Monitor and write 0.0001 in 

the Absolute Criteria box
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2.13 Initialization

Solution → Solution Initialization

◼ Choose Standard 

Initialization

◼ Choose all-zones

◼ Write 373

◼ Click Initialize
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2.14 Run  calculation

Solution → Run  Calculation

◼ Write Number in Time 

Step Size box

◼ Write Number in Number 

of Time Step box 

according to situations 

◼ Write Number in Max 

Iterations according to 

situations 
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2.14 Run  calculation

◼ Time Step Size(s) sets the magnitude of the (physical) 

time step  . Courant number < 1 should be satisfied.

◼ Number of Time Steps sets the number of time steps 

to be performed.

◼ Max Iterations/Time Step sets the maximum number 

of iterations to be performed per time step. If the 

convergence criteria are met before this number of 

iterations is performed, the solution will advance to 

the next time step.

t
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Fig.2 vapor behavior

3 Results
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t=0 s t=1.5 s t=8.5 s t=8.7 s
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Fig.3 Boiling process

3 Results
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Fig.4 Other boiling

results from FLUENT
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Computer-aided project (3) of NHT-2021, XJTU

Known：Natural convection of air in a square filled with porous

media. The left wall is with high temperature, while the right

wall is with low temperature. The bottom and top walls are

adiabatic.

Adiabatic(绝热)

T1=320K T2=300K

0.1m

Find: effects of porosity,

permeability, effective

thermal conductivity and

Gr number on the velocity

field, temperature field

and Nu numbers.
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There is not  a winter that does not pass, 

There is not a spring that does not come.
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同舟共济
渡彼岸!

People in the same 
boat help each 
other to cross to the 
other bank, where….
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